
NEUROMUSCULAR REFLEXES STANDARDS
· 3.3.10.B - Explain cell functions and processes in terms of chemical reactions and energy changes.
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· 3.3.12.B - Evaluate relationships between structure and functions of different anatomical parts given their structure.

INTRODUCTION
The automatic response of a muscle to a stimulus is called a reflex. The patellar reflex results from tapping the patellar tendon below the knee with a reflex hammer. This causes contraction of the quadriceps muscle and extension of the leg. Stretching of the muscle activates nerve impulses which travel to the spinal cord. Here the incoming impulses activate motor neurons, which travel back to the muscle and result in muscle contraction. This reflex arc is primarily a spinal reflex, but is influenced by other pathways to and from the brain (Figure 1).
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Figure 1
A reflex may be reinforced (a term used by neurologists) by slight voluntary contraction of muscles other than the one being tested. For example, voluntary activation of arm muscles by motor neurons in the central nervous system “spills over” to cause a slight activation of the leg muscles as well. This results in the enhancement of the patellar reflex. There are other examples of central nervous system influences on reflexes. Health care professionals use knowledge of these influences to aid in diagnosis of conditions such as acute stroke and herniated lumbar disk, where reflexes may be absent; and spinal cord injury and multiple sclerosis, which may result in exuberant reflexes.

In this experiment, you will use an EKG Sensor to compare the speed of a voluntary vs. a reflex muscle action and to measure the relative strength (amplitude) of the impulse generated by a stimulus with and without reinforcement. You will make a rough calculation of nerve impulse speed using data generated by an Accelerometer used in conjunction with the EKG sensor.


GUIDING QUESTIONS
· Is there a difference in muscle activity between voluntary and involuntary activation?
· How do the relative speeds of voluntary and reflex muscle activation compare?
· What is the approximate speed of a nerve impulse?
· How does the central nervous system influence the reflex amplitude?
· How does the electrical amplitude of reflex responses of different students compare?

SAFETY
Do not attempt this experiment if you have pain in or around the knee. Inform your instructor of any possible health problems that might be exacerbated if you participate in this exercise.
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PROCEDURE

Part I. Voluntary Activation of the Quadriceps Muscle
1. Connect the EKG Sensor and Accelerometer to LabQuest. Choose New from the File menu. The LabQuest does not automatically identify the EKG probe. To do this manually, stay in the Meter mode and select Sensors Sensor Setup….. A sensor set- up screen will appear showing all the available probe ports (Screen a, below). Select the channel that the EKG probe is plugged into (ex. CH1 for channel 1), and tap the arrow to the side of the channel box. A list of compatible probes will appear in alphabetical order.
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Scroll down the list and select “EKG”. Select
[image: ]  to return to the Meter mode screen. A box will now be in this window displaying the channel the EKG probe is plugged into (Screen b, right). The LabQuest is reading electrical potential in mV.

Example of LabQuest Screens and Sensor Set-Up
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a. Sensor set-up screen	b. Meter mode screen


2. On the Meter screen, tap the gray Rate box. Change the data-collection rate to 100 samples/second and the data-collection length to 30 seconds. Select OK.


3. Connect the Accelerometer to the reflex hammer using the cable tie, as shown in Figure 2. Place the Accelerometer cable toward the back of the hammer so it does not get in the way.

4. Have the subject sit comfortably in a chair that is high enough to allow his/her legs to dangle freely above the floor.


5. Attach two electrode tabs above one knee along the line of the quadriceps muscle between the knee and the hip. The tabs should be 5 cm and 13 cm from the middle of the patella (see Figure 3). Use a measuring tape to assist in the placement of these tabs. Place a third electrode tab approximately 10-12 cm below the knee on the lower leg.




Figure 2


6. Attach the red and green leads to the electrode tabs above the knee with the red electrode closest to the knee. Attach the black lead (ground) to the electrode tab on the lower leg.

7. Note: Read all of Steps 7 & 8 before collecting data to become familiar with the procedure. Start data collection by tapping the Start key [image: ]. If the graph has a stable baseline as shown in Figure 4, continue to Step 8. If your graph has an unstable baseline, stop data collection and collect a new set of data by starting data collection again. When prompted, select Discard to delete the old data. Repeat data collection until you have obtained a stable baseline for 5 s.


8. Collect voluntary activation data.
a. Have the subject close his/her eyes, or avert them from the screen.
b. After recording 5 s of stable baseline, swing the reflex hammer briskly to contact the table or other surface that generates a sound.
c. The subject should kick his/her leg out immediately upon hearing the sound.



Green clip




Red clip



Black clip

Figure 3

d. Continue obtaining reflexes (repeat parts c and d of
this step) so that you record 5–10 kicks during the data-collection period. Do not wait 5 s between kicks! The LabQuest will automatically stop taking data after 30 s, so it is important to get at least 5 data points in that 30 s period.

9. Determine the time elapsed between striking the table surface with the reflex hammer and the contraction of the quadriceps muscle.
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Figure 4


a. To analyze the data, tap and drag across the EKG data to highlight the area from just before the table was struck (Fig. 5, upper graph) to just after the muscle contraction (Fig. 5, lower graph).
b. Choose Zoom In from the Graph menu.
c. To examine the data pairs on the acceleration graph, tap any data point. As you tap each data point, the acceleration and time values are displayed to the right of the graph.
d. Tap the first high peak (which corresponds to the first kick) on the acceleration graph (Figure 6). This peak indicates the time at which the table surface was struck. Record this time in Table 1 in the Time of Stimulus row.
e. Tap the first high peak (Kick 1) on the EMG graph. This peak indicates the time at which the quadriceps

muscle contracted. Record this time in Table 1 in the Time of Muscle Contraction row.
f. Choose Autoscale Once from the Graph menu.
g. Repeat this process of zooming in and determining the time of the hammer strike and reflex for a total of five stimulus-kick pairs.
h. Using the equation below, calculate the change in time between the hammer strike and reflex for the five stimulus-kick pairs and then calculate the average change in time for all five pairs. Record the values in Table 1.

Figure 5
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Figure 6


Δ t (s) = Time of muscle contraction (s) - Time of stimulus (s)

10. To store the data for later reference, tap the Cabinet icon [image: ]. Run 1 will correspond with Part I of the experiment.

Part II. Patellar Reflex
11. Locate the subject’s patellar tendon by feeling for the narrow band of tissue that connects the lower aspect of the patella to the tibia. Place a pen mark in the center of the tendon, which can be identified by its softness compared with the bones above and below (see Figure 3, above).


12. Note: Read all of Steps 11 & 12 before collecting data to familiarize yourself with the procedure. Start data collection. If your graph has a stable baseline as shown in Figure 4, continue to Step 12. If your graph has an unstable baseline, stop and collection and repeat data collection until you have obtained a stable baseline for 5 s.

13. Collect patellar reflex data.
a. Have the subject close his/her eyes, or avert them from the screen.
b. After recording 5 s of stable baseline, swing the reflex hammer briskly to contact the mark on the subject’s tendon. If this does not result in a visible reflex, aim toward other areas of the tendon until the reflex is obtained.
c. Continue obtaining reflexes so that you record 5–10 reflexes during the collection period. Do not wait 5 s between kicks! The LabQuest will automatically stop taking data after 30 s, so it is important to get at least 5 data points in that 30 s period.

14. Determine the time elapsed between striking the patellar tendon with the reflex hammer and the contraction of the quadriceps muscle.
a. To analyze the data, tap and drag across the EKG data to highlight the area from just before the tendon was struck to just after the muscle contraction.
b. Choose Zoom In from the Graph menu.
c. Tap the first high peak (which corresponds to the first kick) in the Accelerometer graph (Figure 5). This peak indicates the time at which the tendon was struck. Record this time in Table 2 in the Time of Stimulus row.
d. Tap the first high peak (Kick 1) in the EMG graph. This peak indicates the time at which the quadriceps muscle contracted. Record this time in Table 2 Time of Muscle Contraction row.
e. Choose Autoscale Once from the Graph menu.
f. Repeat this process of zooming in and determining the time of the hammer strike and reflex for a total of five stimulus-kick pairs.
g. Use the equation provided in Step 9h to calculate the change in time between the hammer strike and reflex for the five stimulus-kick pairs and then calculate the average change in time for all five pairs.
h. Record the values in Table 2.

15. To store the data for later reference, tap the Cabinet icon [image: ]. Run 2 will correspond with Part II of the experiment.

Part III. Reflex Reinforcement
16. With the subject sitting comfortably in a chair, start data collection. If your graph has a stable baseline, stop data collection and continue to Step 15. If your graph has an unstable baseline, stop data collection and repeat until you have obtained a stable baseline for 5 s.


Figure 7


17. Collect patellar reflex data without and with reinforcement. Note: Read the entire step before collecting data to familiarize yourself with the procedure.
a. Have the subject close his/her eyes, or avert them from the screen.
b. Start data collection
c. After recording a stable baseline for 5 s, swing the reflex hammer briskly to contact the mark on the subject’s tendon. If this does not result in a visible reflex, aim toward other areas of the tendon until the reflex is obtained. Do not wait 5 s between kicks!
d. After 5 or 6 successful reflexes have been obtained, have the subject reinforce the reflex by hooking together his/her flexed fingers and pulling apart at chest level, with elbows extending outward (see Figure 7).
e. Continue obtaining reflexes until data collection is completed at 30 s. A total of 10–15 reflexes should appear on the graph. You must have at least 5 unreinforced and 5 reinforced data points in the 30 s time period.

18. Determine the minimum, maximum, and ∆y for the depolarization events in this run.
a. Tap and drag across the EMG graph to select the first area of increased amplitude depolarization) in this run (see Figure 8a).
b. Choose Zoom In from the Graph menu and ensure that you have selected an area of data that represents the first area of increased amplitude (depolarization). Highlight the single peak that represents the electrical muscle activity. The peak should now look like the one in Figure 8b.
c. Choose Statistics ► Potential from the Analyze menu.
d. Record the minimum and maximum for this depolarization in Table 3, rounding to the nearest 0.01 mV.
e. Determine and record the ∆y value (amplitude).
f. Choose Statistics from the Analyze menu to turn off statistics.
g. Choose Autoscale Once from the Graph menu.

19. Repeat this process for each of five unreinforced and five reinforced depolarization events, using the Accelerometer to identify each primary reflex. Ignore rebound

responses. Record the appropriate values in Table 3.

20. Determine the average amplitude of the reinforced and unreinforced depolarization events examined. Record these values in Table 3.

Figure 8. Measuring Amplitude of Reinforced Muscle Reflexes
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a. Highlight peak of muscle activity	b. Zoom in for statistics on single peak


21. To store the data for later reference, tap the Cabinet icon [image: ]. Run 3 will correspond with Part III of the experiment.


REFERENCES
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CREDITS
The lab was adapted and revised by Dr. Stephanie Corrette-Bennett.


DATA SHEET

Name:   	 Group:   	  Date:     	 

DATA ANALYSIS

	Table 1

	
	Kick 1
	Kick 2
	Kick 3
	Kick 4
	Kick 5
	Average

	Time of muscle contraction (s)
	
	
	
	
	
	

	Time of stimulus (s)
	
	
	
	
	
	

	∆t (s)
	
	
	
	
	
	



	Table 2

	
	Reflex 1
	Reflex 2
	Reflex 3
	Reflex 4
	Reflex 5
	Average

	Time of muscle contraction (s)
	
	
	
	
	
	

	Time of stimulus (s)
	
	
	
	
	
	

	∆t (s)
	
	
	
	
	
	



	Table 3

	
	Reflex without reinforcement
	Reflex with reinforcement

	Reflex response
	Max (mV)
	Min (mV)
	∆mV (∆y)
	Max (mV)
	Min (mV)
	∆mV(∆y)

	1
	
	
	
	
	
	

	2
	
	
	
	
	
	

	3
	
	
	
	
	
	

	4
	
	
	
	
	
	

	5
	
	
	
	
	
	

	Average values
	
	
	
	
	
	




QUESTIONS

1. Compare the reaction times for voluntary vs. involuntary activation of the quadriceps muscle. What might account for the observed differences in reaction times?












2. Using data from Table 2, calculate speed at which a stimulus traveled from the patellar tendon to the spinal cord and back to the quadriceps muscle (a complete reflex arc). To do this, you must estimate the distance traveled. Using a cloth tape measure, measure the distance in cm from the mark on the patellar tendon to the spinal cord at waist level (straight across from the anterior-        superior iliac spine–see Figure 9). Multiply the distance by two to obtain the total distance traveled in the reflex arc. Once this value    has been obtained, divide by the average       ∆t from Table 2 and divide by 100 to obtain the speed, in m/s, at which the stimulus traveled.


[image: ]
Figure 9











3. Nerve impulses have been found to travel as fast as 100 m/s. What could account for the difference between your answer to Question 2 and this value obtained by researchers?


4. Assume the speed of a nerve impulse is 100 m/s. How does this compare to the speed of electricity in a copper wire (approx. 3.00 108 m/s)?








5. Compare the data you obtained in this experiment with other members of your group/class. Can individual differences be attributed to any physical differences (body shape/size, muscle mass, physical fitness level)?
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